Manitoba Education

Social Studies Manitoba ™™

GIS in the classroom

Locating Provinces, Territories and Capital Cities on a
Map of Canada in ArcGIS 9.x
Introduction:

In this exercise you will learn how to create a map of Canada using ArcGIS 9.2 GIS
software, and to locate and label the provinces, territories, and capital cities. If you have
used ArcGIS 9.2 before, you will be familiar with the tools and buttons required for this
activity. If you are new to ArcGIS 9.2, be sure to read and follow all the instructions
carefully. You may need to refer to an Atlas of Canada to help you locate the capital
cities later in this lesson.

Author: Al Friesen — Updated for ArcGIS 9.2 by Ani Granson and Rob Langston
Grade Level: Grade 4 -10

Social Studies Learning Outcomes

Students will:

4 KL-019 Locate provinces, territories and capital cities on a map of Canada

6 KL-025 Locate on a map of Canada the provinces, territories and capital cities

9 KL-024 Identify on a map distinguishing elements of the physical and human
geography of Canada (include political boundaries, capital cities)

10 KL-013 Locate provinces, territories and capital cities on a map of Canada

10 S-201 Organize and record information in a variety of formats and reference
sources appropriately

10 S-202 Select and use appropriate tools and technologies to accomplish tasks
10 S-203 Construct maps using a variety of information sources and technologies
10 S-204 Select, use and interpret various types of maps

Note: When creating projects in ArcGIS, it is best to create a new folder for each project
to save to. You can give the folder a name that corresponds with the nature of your
project. Whenever you add or create theme layers in your project, select the
corresponding folder to save your changes. Also, note that the directory paths shown in
the screen shots will differ from the paths in your system. Ask your instructor if you
need help creating a folder or selecting an appropriate file directory.
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Required Files: ArcCanada 3.1 Disk 1
e National/shp/canada2001.shp
e National/shp/cities.shp

Instructions:
1. Launch ArcMap, when prompted choose a new empty map.

Start uzing Archdap with

@ " A template

Templates provide ready-to-uze layouts and base maps
for warious geographic regions.

ﬁ; (A existing rmap:

Browse for maps...

[w Immediately add data
[ Do not zhow thiz dialog again (]
[ Load lazt map on startup

2. Using the Connect To Folder button navigate to the location of
Canada2001.shp. The file path will be different in your setup. If you do not
know where the ArcCanada data is stored, ask your instructor for help.

Add Data
Laak ir: |@ G:\LangstorhGIS ars n::anau:la'l'xNalj fa ;}|g;|_. slas EEZ Eg|
E water shp =] med_cities_Fuffer_Buffer .
Fomma cba chn FTll o cibiae Buiffar chn jConnect To Folder

3. Highlight the canada2001.shp label, then click the Add button to this theme
layer to your map. An outline map of Canada should appear in your data frame
(view); you will change the projection in #5 below.
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Add Data X

Laak ir: |[3 G:\LangstorGlShare canada 'I'\Nalj H ;}| |

= islands. shp cd_1996,shp [ background
] hist_sites . shp cd_1991.shp

= greatlakes. shp B capital cities canada.shp

= fed.shp @capital cities 9. lvr

canadaz00l.shp
= ecozones shp canadal?9a,shp
= ecoregions.shp area_codes,shp
2 cities. shp 5d_grid.shp

= cd_z001.5hp [ limage

st |EIEI |

< >
Mame: |canada2ElEl1 shp Add
=how of type: |Data$et$ and Layers [*lyr] j Cancel

4. Using the Add data button + navigate to the location of cities.shp and add
this shapefile to your map. (This should be located in the same location as
Canada2001.shp)

5. This is a good time to save your project. Go File > Save As, navigate to
the folder you created for your project, create a title for your project, and select
Save. Save your project frequently as you go along.

6. To make the map appear more accurate you can change the projection. To do
this, double click on the Layers in the table of contents.

- canadaz00l
|

7. The desired projection is North America Lambert Conformal Conic. To obtain
this projection, select the tab Coordinate system and in the selection box select
Predefined - Projected Coordinate System - Continental = North
America and select North America Lambert Conformal Conic. Hit Apply and
OK. (If warning messages appear select OK to continue).
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Select a coordinate systen;

@ Canada Albers Equal Area Conic ”~ Fodify... |
M Canada Lambert Conformal Conic
@ Hawai Alberz Equal Area Conic Import... |
% Morth America Albers Equal Area Conic
% Morth America Equidistant Conic Mew -
@ Morth America Lambert Confarmal Conic
@ 154 Contiguous Albers Equal Area Conic Add To Favarnites |
@ 154 Contiguousz Albers Equal Area Conic 3

m LI W i T Y RPN SRR iy Y T o - |

4 b

k. | Cancel | Apply |

8. To enlarge your map, select the Zoom In button ® from the toolbar and draw a
box around Canada, the map will enlarge to fill the Data Frame (View).
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9. Itis now time to add the capital cities to your map of Canada. The ArcCanada
cities theme contains a large number of cities; however, for this exercise we only
want the capital cities. You can select the capital cities from the Cities Attribute
Table in this file (#10 below) or you can Digitize your own cities theme (#16
below). If the social studies outcome requires students to locate and label the
capital cities, then you should proceed to #16 (in the case of Grade 10).

10.To select the capital cities from the cities attribute table, right click on cities in
the table of contents and left click on Open Attribute Table.

SR = Layers ‘
= citicy
e 3B Copy
= canz ¥ Remove

[]-
[ Dpen Attribute Table

ki Jnins and Relates 2
CE —

11.With the attribute table open, right click on the Capital column heading and
select Sort Descending. All capital cities will be moved to the top of the table
and will now have a value of 1,2,or 3 in the Capital column.

IYEers

B Attributes of cities

FID | Shape* | CAPITAI i POP RANGF | HARE_EH
| 0lPaint ' on
| 1 /|Poirt
| 2|Poirt

3 |Pairt Summarize. . .
| 4 |Paint 21 Statistics. .. r
= [ Fmirmd

12.With the attribute table still open, highlight (select) all the capital cities by moving
your cursor to the small upper left corner box (see screen shot below), click and
hold as you move the cursor down to select all the capital cities — they should
now be highlighted. In the options bar below the table, go to Show and click on
Selected.
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E| Attributes of cities ._ E|r>__<|
| FID | Shape™ [CAPITAL] POP_RANG | NAME_EN
_* 245 | Paint 3 2| Iqaluit =
o 466 | Point 3 3 'whitehorze
u 4E7  Paint 3 3 ellowknife
n 455 | Paint 2 B Wictoria
u 456 | Point 2 E|Reqgina
u 457 Paint 2 & Toronto
u 453 Point 2 B Québec
u 460 Point 2 4 Fredericton
n 461 | Paint 2 3 Charlottetown
| 462 | Point 2 6 Halifax
u 463 Paint 2 B 5t John's
u 464 | Point 2 B wWinnipeg
u 4E5  Paoint 2 E | Edmonton
n 453 Paint 1 B Ottawa
| 0| Paint I} 2 Port Hope Simpson
1| Puoint 0 2| Hopedale e
< | b/
Recaord: ﬂﬂ I} ﬂﬂ Shawe | Al Selected | Recards [14 out of 497 Selected.)
h —

13.Close the attribute table. In the table of contents in your map, right click on the
cities layer and go Selection = Create Layer From Selected Features.

&= Layers ‘
)
& Capy
= car Rermove
Open Attribute Table

Joins and Relates .4

[} @g Zoom To Laver

onm

Wisible Scale Range 3

Use Symbol Levels

Selection » @?‘ Zoom To Selected Features
Label Features @ Pan To Selected Features

[ dear Selected Features

EEEENEEEERN

% Switch Selection
B select al

‘f-'? Convert Features ko Graphics. ..

Data » Make This The Only Selectable Laver

Save &s Layer File. . Copy Records For Selected Features

Properties. ..

Create Layer Fro

Cpen Table Showing Selected Features
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14. There should now be a layer called cities selection in the table of contents.
Right click on cities selection and go Save As Layer File. Save this new layer
as Capital Cities in the same location (folder) where you saved the project.

15.The cities layer in the table of contents is no longer needed. It can now be
turned off by clicking on the checkmark in the small box next to it. Alternatively,
you can delete this layer by right clicking on cities and left click on Remove.
Proceed to #17 below.

16. OPTIONAL: An alternative method of creating the capital cities theme is by
Digitizing a new theme. (You can see a more detailed explanation of digitizing in
ArcGIS 9.2 Toolbox found on the GIS in the Classroom website of Manitoba
Education). To create a new theme by digitizing:

e Open ArcCatalog & and next to Location navigate to the folder where
you saved your project.

e Go File > New - Shapefile

e Name the new file Capital Cities and under Feature Type select Point,
and hit OK.

e Close ArcCatalog.

e Click the Add Data button \"/", navigate to the newly created theme and
add it to your data view.

e Using the Editor button A activate the Editor toolbar, and select - Start

Editing - and navigate to the folder where you saved your project -
ensure that the new Capital Cities theme is selected (it will likely be the
only one shown)

e Now select the Sketch Tool 4 and draw a point at the locations of all
the capital cities in Canada (you may need to refer to an atlas or online
map of Canada).

e When you have marked each location, go Editor - Stop Editing and
Save your edits.

17.You can edit the entries in the table of contents (e.g. change canada2001 to
Canada) by clicking once on the theme name to highlight it, then clicking once
on the highlighted line to make it editable (the cursor will appear). Similarly,
change the cities selection title to Capital Cities.

18.You can improve the appearance of your map by giving each province and
territory a different colour symbol. Double click on Canada in the table of
contents, select the Symbology tab - Categories = Unique Values. Here you
can also select your choice of Colour Scheme. Under Value Field select
Name; then select Add All Values - Apply = OK.
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Layer Properties

General] Su:uuru:e] Selection | Display  Spmbalogy l Fields ] Drefinition E!uer_l,l] Lal:uels] Joing & Helates]

Sho:

2 . : ; i I E..
Foatures Draw categories using unique values of one field. {mpor
Categories Walue Field Lalor Ramp

Unique values NaE ﬂ |- ‘n11m j

Jnique walues, many |
batch to symbolz in a
Quantities
Charts
Multiple Attributes

KEY

NOM bel | Count |

POP_2001 other values:
DWELL 2001
PRCODE
ARES KM

1|
3

Add Al Values | Addvalues... | | Remove &l | Advanced

] | Cancel | Apply |

] L R

19.Double click on Canada in the table of contents, select the Symbology tab, click
on Categories and under Symbol uncheck the box which is associated with <all
other values>.

] — |
i
2| | W AL Label
|:| all other values > <all other values:
tHeading> HAME
- Alberta Alberta
[ Britizh Columbia Britizh Columbia

20.The capital cities have now been located, but they require labeling. Use the

Label Tool & , select the kind of labels you want, and then click on the location
of a capital city. When a textbox appears type in the appropriate name.

YWinnipeg
&
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21.1f you make a mistake while labeling, use the Select Elements button R and
double click on the incorrect text; a new textbox appears to start over.

22.Now your map of Canada is completed and it is time to create a Layout which
allows you to add all the necessary map basics such as legend, scale, north
arrow, name, title and border. The easiest way to complete this is by using a
map layout template. Click on View in the toolbar and select Layout View and
then click on the Change Layout in the Layout toolbar.

‘@E}@ EY B B3 [ [ 0 |7ax - ”\

=
‘ Change Lawyout

23.0nce you have clicked on the Change Layout button, click on the General tab,
select Letter Landscape and click on Finish. You should now see a map with
all necessary map components. (Whatever is visible in the Data View will appear
in the Layout View. If your map is too small or too large, use the zoom tools in
Layout toolbar to zoom to the appropriate size).

‘IE}IE;I@:E]EHI; 5% x| am

o

<Double-click to enter map title>
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24.Using the cursor double click on the title line and add an appropriate title.

25.Double click where prompted and add your name and date.

26.Using your cursor click on and drag the north arrow and legend to a suitable
location. You can change the size of the legend and north arrow by clicking on

the item and dragging the corner to enlarge or reduce the feature.

27.Double click on the Scale and under the Scale and Units tab, go to Units -
Divisional Units and change the units to Kilometers.

28.Your map is now complete and the layout is ready to show to your teacher, or for
printing.

Optional Activities: (Return to the Data Frame)

1. Using the Identify button o found on the toolbar, click on any city/province or
territory. This will give you the attribute data associated with the feature on the
map. This demonstrates a key feature of ArcView that links information with
geographic locations. You can see all the data in a table when you open the
attribute table for a specific theme layer.

i

2. Using the Measure button = you can measure the distance between two
locations on the map. Click once to start measuring, click once to change
direction, and double click to end the measurement. The distance is displayed in
the bottom left of your screen.
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